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SIDRA INTERSECTION 9.0  
UPDATE HISTORY 
 
 

Version: 9.0.3. 9771 
Release Date: 5 October 2020 

Enhancements 
• Improvements to the User Guide and Help System. 
• Improved operation of tabs so that the current Output tabs remain visible when switching to the 

Tools or Manage tabs.  This makes it quicker to move between the Tools or Manage tab and the 
Output tabs. 

• Added the Site ID and Site Name to the Network Site image's right-click menu in the Network 
Configuration dialog.  This helps when configuring large Networks. 

• The Wide-Median Intersection Network template has been improved. 
• Several improvements were made to the Output to PDF function when the "separate file" option is 

used.  These include prevention of overwriting existing PDF files when multiple files are generated 
with the same name, prevention of selecting options that would lead to an empty filename and better 
handling of filename generation when the Site names include the slash or backslash character. 

• Improvements to error checking for Exit Short Lane specifications. 
• When a Network folder is selected, all buttons in the Route Output ribbon are now disabled. 

Previously, these buttons could be clicked but did not do anything. 
• Phase Sequence Name has been added for each Site / CCG in the Network Signal Phase Timings 

report. 
• Demand Flows (and also Arrival Flows for CCG cases) have been added to the Multiple Sequence 

Analysis report. 
• Added new API function to move Site / Network to another folder. 
• Quick Input is now available for all Lane Colour and Lane ID options. 
• Minor improvement to the Pedestrian Signal Timing Display. 

Bug Fixes 

• An "unexpected end of file" error that occurred sometimes and prevented SIDRA from starting has 
been fixed. 

• The Roundabout Pedestrian Effects table was missing from the Detailed Output. 

• A calculation problem which led capacity reduction not being applied to some upstream continuous 
lanes in some Network cases has been fixed.  

• Fixed an error that occurred sometimes after clicking the Process button in the Network Data dialog. 

• Fixed an error that occurred in Site Input Comparison when comparing Lane Flow Proportions for two 
Sites that had a mismatch in the number of lanes. 
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• Fixed a bug with resetting of Turn On Red movements when Variable Phasing was used.  This led to 
unexpected variations in cycle time when comparing a fixed phase sequence and a variable phase 
sequence that resulted in the same set of phases. 

• User-Specified Conflict Zone Length for Zebra Crossing was ignored, and a program-calculated value 
was being used in all cases. 

• Fixed some problems related to Midblock Unsignalised (Zebra) Crossings when a staged pedestrian 
crossing was specified. These related to assumptions about priorities and reporting of Gap-Acceptance 
Parameters.  

• Fixed a calculation problem at Midblock Unsignalised (Zebra) Crossings when only one stage of a 
staged pedestrian crossing was specified. 

• Fixed a problem at Midblock Unsignalised (Zebra) Crossings that led to inconsistent reporting of delay 
values when the HCM Delay Model was used. 

• Prevented some cases of the zoom bar disappearing from in-dialog displays. 

• Spurious approach name row headers for pedestrian movements in various reports have been removed 
for cases where the approaches have no signalised pedestrian movements. 

• The Diagonal Pedestrian Crossing icon was wrongly showing in some in-dialog displays at All-Way 
Stop Control Sites. 

• Fixed some incorrect tab header tooltips for CCG reports. 

• Fixed an error that sometimes occurred when the Network Approach and Exit Distances display was 
open and data was changed. 

• Approach values for Travel Time (Average) in Network Displays were appearing as zero.   

• Approach values for Travel Distance (Total) in Network and Route Displays were not shown. 

• Fixed a Network processing problem related to Routes where a Movement Class was not included at 
all Sites in the Route. 

 

 

Version: 9.0.2.9732 
Release Date: 16 July 2020 

Enhancements 
• Significant improvements to the User Guide and Help System. 
• Improved access to Map Extract User Guide – it is available even if a map is not opened and is also 

accessible via User Guide, Glossary & Help in the File tab. 
• Improved notes in Map Extract - Import Preview dialog. 
• Set better phase sequence names when Map Extract and Site Convert are used. 
• Improvements to Network Diagnostics. 
• Improved method for specifying range limits for User Speed Efficiency in the Network Data dialog, 

Settings tab. 
• Extra Phase Sequence options added to Signalised Diamond Interchange Network Templates. 
• Arrows in Network Project Tree remain visible regardless of mouse cursor position to assist users to 

identify which Networks have Routes defined. 
• Simplified messages in Site and Network deletion dialogs. 
• New functions introduced in API for removing Site / Network / Route Output data. 
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• Displayed timings for vehicle and pedestrian movements were introduced in the Movement Timing 
display including presentation of timings reduced due to Pedestrian Actuation, Minor Phase 
Actuation and Phase Frequency specifications.  The improved display visualises the timing data in 
the Timing Analysis and Pedestrian Analysis reports.  

• Improvements to various output reports. 
• Improved reporting of continuous movements and lanes in the Roundabout Analysis Report and in 

Roundabout tables in the Detailed Output. 
• Improved information (blue text) in some input dialogs. 
• Improvements to Site Layout pictures. 
• Improvements to installation process to make it less likely to encounter errors. 
• Improvements to licensing procedures and messages within the software. 
• Improvements to some error messages. 
• Set a consistent lower limit of 0.1 for all End Departures and Minimum Capacity parameters in the 

program. 
• Python Sample Programs modified so that they will work when both Version 8 and Version 9 are 

installed on the one computer. 
• Improved folder browsing in the Output to PDF dialog. 

Bug Fixes 

• Fixed a bug that prevented entry of lane width and roundabout environment factor when comma was 
used as the decimal separator. 

• Fixed a problem that prevented use of the Lane Geometry dialog and the Layout Options dialog when 
using the software under Windows 7. 

• Fixed a bug that caused Error 597 to occur for some variable phase sequence cases despite valid 
sequences being specified. 

• Fixed incorrect setting of Reference Phase in some Variable Phasing cases. 

• Fixed a bug that caused incorrect capacity calculation for some shared low-angle slip lane cases. 

• Fixed a problem with Map Extract where the map file name was stored even when it had errors. This 
led to the error recurring each time Map Extract was used.  In this situation now, the user will be 
prompted for a new map file name when subsequently using Map Extract. 

• Fixed a bug that caused reporting of “NaN” delay values. This was related to a problem in the 
downstream merge delay calculations when one of the lanes had zero flow. 

• Fixed a problem when importing some Sites in Map Extract which led to the error “Sequence contains 
no elements”. 

• Fixed a problem in Map Extract where lanes at some signalised Sites were imported with Stop Control. 
This prevented phasing specification for movements using these lanes. 

• Fixed a bug that caused Network selection to jump to a different Network when Site Movement 
Definitions were changed. 

• Fixed a problem with Sequence selection in the Phasing & Timing dialog following import of a 
Sequence from another Site. 

• Fixed a graphics problem in the Sequence Editor in the CCG Phasing & Timing dialog. 

• Fixed incorrect display order for some Approach and Exit Flow displays and for some Staged 
Pedestrian displays. 

• Fixed some problems with Time-Distance diagrams and Interactive Offsets, mainly related to 
movements with 100% green. 
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• Fixed a problem with the options available in right-click menus in Site and Network reports and 
displays. 

• Fixed a problem with the Route Configuration which prevented selection of areas under blue text. 

• Fixed a bug with Input Comparison that highlighted a zero Free Queue value as being different to the 
default value in some cases. 

• Fixed an error that sometimes occurred when Sites were modified when the Project Summary report 
was open. 

 

 

Version: 9.0.1.9664 
Release Date: 20 May 2020 

This is the first release of SIDRA INTERSECTION 9.0.  The new features of this version available in the 
first release are listed below.   

General Software Changes 
• Maximum number of Sites per Network has been increased from 20 to 50.  
• Various measures implemented to increase processing efficiency.  
• Database changed from SQL Compact to SQLite.  A substantial reduction achieved in 

project file size (in the range 40% to 80% decrease for sip9 file compared with sip8 file).  
• FLOATING x Pack licences have been replaced by SPECIAL x Pack licences.  

NETWORK model capability will be available for this type of licence. 
• The project database file (sip9) includes new input and output data.  Previous version 

project files can be imported into Version 9.   
• VOLUMES utility updated for Version 9.  
• API updated for Version 9 and is ready to use.  

Site and Network Templates 
• Site Templates are updated for Version 9.  Unsignalised Pedestrian Crossing template is 

removed since it is now available as a Site Type in the Add New Site group. Freeway 
Interchange and Staged Crossing templates are removed since a new Network templates are 
available.  Hook Turn, Left-In Left-Out, Right-In Right-Out and Freeway Segment with 
Ramps Two-Way templates are added. 

• New Network Templates are prepared to make setting up complex intersection and 
interchange designs simpler and less time consuming.  Selected Network Templates can be 
included in the current Project using the Import command.  The Network Templates library 
includes:   
o Alternative Intersections 

 Continuous Flow Intersection (CFI) - Full and Partial 
 P-Turn 
 Restricted Crossing U-Turn (RCUT) with Independent Signals and with Single Controller 

o Interchanges 
 Divergabout 
 Diverging Diamond Interchange (DDI) 
 Double Roundabout Interchange (DRI) 
 Signalised Diamond Interchange (SDI) 
 Unsignalised Diamond Interchange (UDI) 
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o Paired Intersections 
 Signalised Roundabout (3-Lane Circulating and 2-Lane Circulating) 
 Wide-Median Intersection 
 Staggered T - Signals (Right - Left and Left - Right) 
 Staggered T - Unsignalised (Right - Left and Left - Right) 

o Roundabouts 
 Double Teardrop Roundabout 
 Roundabout with Signalised Pedestrian Crossings 
 Roundabout with Zebra Pedestrian Crossings 

o Staged Crossings 
 Staged Crossing at Four-Way Intersection 
 Staged Crossing at T-Intersection (3 Types) 

User Interface 
• Map Extract tool to create new Sites from map data.  
• Graphical Interactive Offsets function using Time-Distance displays for the user to modify Offsets 

towards achieving two-way signal progressions.  
• Two-way Time-Distance displays with different orientation options.  
• Enhanced Signal Offset calculations with continuous movements.  
• Pedestrian Crossing (Unsignalised), also called "Zebra Crossing", introduced as 

applicable to unsignalised Slip / Bypass lanes (available for all Site types) and midblock 
locations (available as a new Site type to replace the Zebra Crossing template in previous 
versions).  

• Software Info section introduced in the File tab.  
• New tab and ribbon structure: 

o  Network and Route tabs combined.  
o Separate output tabs for Sites, Networks, Routes and Network Sites.  

• New Project Pane Structure: 
o Folders to group Sites, Networks and Routes.  
o Routes belonging to each Network appearing under the Network in a tree 

structure. 
o SITES & CCGs IN NETWORK / ON ROUTE sections indicating CCGs and their 

Sites in a tree structure. 
o Colour strips to the left of the Site Name and Network Name in the SITES and 

NETWORKS sections of the Project Pane indicating the Diagnostics status. 
• Optional separate Display Panes for Site / Network/ Route / Tools tabs allow control of a 

large number of reports and displays under the relevant tabs.  
• The Settings tab has been renamed as the Manage tab and includes much enhanced dialogs for 

setting Customise Output (Site, Network, Route), Displays (Approach, Movement, Lane), Site 
Output (Detailed Output, Volume Displays), Interface and Layout options.  Customise Output allows 
the user to control output sections (choose to include or not) and define Page Breaks in output reports 
and displays.  

• Category Setup facility under the Tools tab.  
• Sequences tab of the Phasing & Timing dialog modified to allow Multiple Sequence 

selection.  
• Import Phase Sequence: Phase Sequence can be imported from another Site.  
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• Quick Input for Site, Network and Route data extended with new options.  
• Reset to Defaults function for Network Analysis Settings.  
• Delete Network with Sites option introduced.  
• Export Site and Export Network functions added to make copies of selected Sites and 

Networks in a new Project the function creates.  
• Option to open the default in-dialog displays automatically in Site and CCG input dialogs.  

Output Reports and Displays 
• PDF Output function to save the output reports and displays in a PDF report.  
• Roundabout layout displays allow variable size according to the Central Island Diameter 

size.  
• Roundabout layout displays can show elliptical roundabout shapes when Central Island 

Diameter sizes differ for different approaches (subject to some exceptions).  
• Layout displays allow Strip Island connections as specified by the user in the Lane 

Geometry dialog.  
• Layer order in Network layout pictures to control vertical position of roads specified by 

right clicking the connection arrows and connection bars in the Network Configuration 
dialog.   

• Approach Displays, Lane Displays, Movement Displays, Lane Flows, Movement Flows displays 
available for Sites, Networks and Routes consistently.  

• Input Volumes added to all Movement Flows displays and to the Movement Summary report for 
single Site analysis.  

• Queue Analysis report introduced.  
• Pedestrian Analysis report introduced.  
• Fuel, Emissions & Cost report introduced.  Vehicle Operating Cost and Time Cost in 

addition to the Total Cost are reported in the Detailed Output report.  
• Multiple Sequence Analysis report introduced.  
• Timing Analysis report enhanced significantly with detailed information on Pedestrian Actuation 

and Phase Actuation analyses. 
• Critical Movements shown in the Movement Summary report.  
• New CCG reports and displays showing all CCG Sites in the same report or display.  These 

include Movement Summary report and all displays except Lane LOS, Movement Displays 
in Classic format, Demand and Arrival Flows.  

• Enhanced Saturation Flows reports.  
• Roundabout Circulating Flows display includes Movement Class details. 
• Exit distances for external exits added to the Approach Distances display for Networks.  
• Numerous other improvements to Site, Network and Route output reports and displays.  

Model Improvements 
• Progression of vehicle platoons using continuous lanes at multiple unsignalised and 

signalised Sites between two signalised Sites. 
• Unsignalised (Zebra) Pedestrian Crossing on Slip Lanes. 
• Staged pedestrian crossings with selectable elements (approach or exit side crossing can 

be specified as not existing).  
• Merge Model for exit short lanes at any type of intersection with Priority Merge and Zipper 

Merge.  
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• Model for U-turn before intersection. 
• Short Lane Model calibration options.  
• Option to exclude Saturation Flow estimation for user-specified saturation flows ("Apply 

Saturation Flow Estimation" checkbox).  
• Option to exclude lane blockage effects on capacity reduction in Network analysis.  
• Multiple Phase Sequence analysis in Site timing calculations.  
• Variable Sequence selection criteria enhanced.  
• Pedestrian Timing input enhanced by introducing the Clearance 1 parameter for Pedestrian Timing 

calculations.  
• Efficiency Parameters including Desired Speed by Movement Class for Sites, Networks and Routes 

with enhanced modelling of Speed Efficiency, Congestion Coefficient and Travel Time Index 
parameters.  

• Continuous movement (uninterrupted flow) model enhanced and detailed performance 
estimates included in output.   

• Midblock Effective Detection Zone Length parameter in Site parameter Settings dialog for 
use in the continuous movement (uninterrupted flow) model.  

• Gap Acceptance Factor, Opposing Vehicle Factor and Passenger Car Equivalent defaults 
for the Light Rail / Trams Movement Class are changed (increased) to the same values as 
Large Trucks.  
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